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elcome to the 47™ Edition of The Leadership

Ledger. It includes Post, Dept. and Nat’l re-
ports, leadership training events, upcoming confer-
ences/ conventions as well as rules and regulations
pertaining to local, state and national laws. The
Ledger is available by visiting the Department’s
website at www.mainelegion.org under “News &
Events” or on the home page. If you have any infor-
mation to be published in The Leadership Ledger,
please forward to Department HQ via email at:

legionme@mainelegion.org.

DISTRICT MEETINGS

Be Connected — Be Heard — Be Informed

District 5 — Oxford: Aug. 17
Locke Mills Post 68, 7:00PM
NOTE: Cookout canceled due to Covid19.

District 6 — Knox: Sept 25
St. George Post 34, 9AM

District 14 — Piscataquis: Sept. 18
Guilford Post 119, Noon Lunch w/Bus. Mtg @ 1PM

District 17 — No. Aroostook: Sept. 12
Stockholm Post 136, 1PM

Note: If you haven’t submitted your
district meetings for 21-22, please
do so as soon as possble!
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STATE OF MAINE

w® Bicentennial)
PARADE

STATE OF MAINE
BICENTENNIAL PARADE
AUGUST 21, 2021
AUBURN-LEWISTON

American Legion Family Parade Application
Parade Participant Information

he American Legion, Department of Maine, has

already registered to be part of the Maine State
Parade on August 21, 2021. The Department would
like to have a large contingent of Legionnaires
participate in the parade. Currently, we have one
POW/MIA float that will be part of the parade and
several Posts that have expressed interest in marching.
We would like all Posts to part of this great event. It
was postponed several times due to COVID-19, but
it is definitely happening on August 21, 2021. Please
show your support and show the State of Maine our
numbers by signing up your Post to participate.

Click on: American Legion Family Parade Application
to download. Parade information is also available by
visiting: www.mainelegion.org under NEWS & EVENTS.

You may also contact Dept. 2" Vice Commander Al
McKay at 380-1582 or e-mail him at:

boppam@yahoo.com

MEMBERSHIP IMPACT REPORTS

he American Legion's success depends entirely

on active membership, participation and volun-
teerism. The following monthly reports located on
https://www.legion.org/membership/impact pro-
vide a summary of membership, participation and
volunteerism making an impact in the lives of veter-
ans, families and communities. American Legion
Posts can share the many ways Legionnaires are
making a difference in their communities by sub-
mitting consolidated post reports online. To Vvisit
the impact American Legion posts made throughout
the year, visit:

https://www.legion.org/bythenumbers or
https://www.legion.org/membership/impact.
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eé-Postcard

file your electronic IRS Form 990-N

EXEMPT ORGANIZATIONS
E-FILE-E-POSTCARD

What is the electronic filing requirement for small
tax-exempt organizations?

B eginning in 2008, small tax-exempt organizations
that previously were not required to file
returns may be required to submit an annual
electronic notice, Form 990-N, Electronic Notice
(e-Postcard) for Tax-Exempt Organizations not
Required To File Form 990 or 990-EZ. This filing
requirement applies to tax periods beginning after
December 31, 2006. Organizations that fail to meet
their annual filing requirement for threeconsecutive
years are subject to losing their tax-exempt status.

Small tax-exempt organizations, whose gross
receipts are normally $50,000 or less, are not
required to file Form 990, Return of Organization
Exempt From Income Tax, or Form 990-EZ, Short
Form Return of Organization Exempt From Income
Tax. These small tax-exempt organizations are
required to file electronically the e-Postcard, Form
990-N, with the IRS annually. Exceptions to this
requirement include organizations that are included
in a group return, private foundations required to
file Form 990-PF, and section 509(a)(3) supporting
organizations required to file Form 990 or Form
990-EZ. In addition, this filingrequirement does not
apply to churches, their integrated auxiliaries, and
conventions or associations of churches.

See e-Postcard (Form 990-N)
for more information about this requirement.

Page Last Reviewed or Updated: 04-Mar-2021

MILITARY TRIVIA:

Q: What was very unusual about the 4 “/OWA

Class” fast battleships, used to quickly cross the
oceans in WWII, to engage the enemy in it’s own
backyard? (USS Iowa, USS New Jersey, USS
Missouri & USS Wisconsin)?

NEW MYLEGION.ORG
INSTRUCTIONS/INFORMATION FOR

Q LEGION.ORG Hember Name
Jem—

HONOR & REMEMBRANCE
Honor and remember those who have serves

MEMBERSHIP PROCESSING, GROUP
PERMISSIONS & MORE!

Now that the myLegion site is live, all accounts
are now MEMBER accounts. This includes Le-
gion and SAL members. The first requirement to ac-
cess post and squadron data is to create a myLegion
member account using the email address on your
membership record. The new myLegion Home page
will look like the image above. It provides links to
your subscriptions, discounts, and resources. MY
ACCOUNT provides more information about your
own membership. To learn more, please click on the
image or title above for information and instructions
or the Video Presentation / PowerPoint links below.

Video Presentation / PowerPoint / Q&A

PUFL CARD MAILING

This message is just to let you know that our annual
PUFL card mailing for your American Legion
membership will occur later this month due to
testing needs with our new computer system. Since
this is a new process, we want to ensure that the
PUFL cards and mailing requirements meet
expectations. Normally, we’d have the cards in the
mail by the end of June so we just wanted you to
know that your 2022 card is simply delayed...and
not lost.

Thanks very much for your membership and support
of The American Legion!

#/g/e//a A /t///g/

IT/Deputy Director, Member Support Services
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MAINE LEGION COLLEGE
CLASS FOR 2021

e are currently working on the next Maine

Legion College Classes for the 2021 year.
As in the past, you have to make a commitment but
we know that you will gain much from these clas-
ses and from other Legionnaires from all over the
State of Maine.

Classes will be scheduled starting in September.
Dates have currently been changed due to other
events and conflicts.

Classes start at 8:30am each day:
Phase 1: Sept. 18 & 19

To attend these classes, you must first go online at:
www.legion.org/alei and complete the Basic
Training Course. After completion, please forward
a copy of the Certificate to us at State HQ. You
may scan the document and send it by email to
paul@mainelegion.org along with your Name,
Post No., and Cell Phone No.

VETERAN'S EMERGENCY
FINANCIAL ASSISTANCE
PROGRAM (VEFAP)

Do you know of a veteran in your community
in need of assistance? Someone who during
these challenging times just needs a little help to
keep them going? Maybe a veteran that is home-
less? Or worst of all, a homeless veteran with
children? If so, we want to remind you that The
American Legion, Department of Maine can assist
you to help these veterans during their difficult and
troubling times.

You can call us at 207-873-3229 Ext. 3 or visit our
website:

http:/www.mainelegion.org/pages/resources/va-
resources.php

We will contact you as soon as possible and we
hope to enable you to help veterans in need.

Member
Benefits

Special discounts
and services for
Legionnaires

For more information CLICK HERE or visit:
https://www.legion.org/benefits

Show your Support to our Veterans in the State of Maine! ,
MAakE A DoNATION ToDAY!

AMERICAN LEGION

DEPARTMENT OF MAINE
FOUNDATION

(a 501(c)(3) nonprofit organization)

The American Legion Department of Maine
Foundation, a 501 (¢) (3) charity organization is
now up and running! Please click here or the
FOUNDATION tab above to learn more.

AmazonSmile donates to the American Legion
Department of Maine Foundation.
Shop AmazonSmile and make a difference today.

AMERICAN LEGION

FLAG}&(EMBLEM

SERVING VETERANS. SERVING AMERICA.

NATIONAL COMMANDERS
CAMPAIGN

o Our Fellow Legionnaires:

As you may be aware, each year we request
donations to be given to the leading candidate for the
position of National Commander of The American
Legion. The individuals do a lot of traveling and have
expenses which they may need assistance in covering.

We are asking you to consider donating to this
great cause so that the Department of Maine can
support the leading candidate, Vincent James
Troiola in their quest for election to the high
position of National Commander.

Each department donates to this cause and we
are not the only one to do so. The many departments
also supported our own Tony Jordan when he was
campaigning for National Commander and it is only
right that we, the Department of Maine, do so also.

Your donations will be greatly appreciated.
Please send them to the Department of Maine
Headquarters at 5 Verti Drive, Winslow, ME 04901
and earmark in the “Memo” position of your check
or money order “National Commander Donation.”

The donations will be given to the lead candidate,
Mr. Troiola, at the soonest possible time.

Thank you and let’s make this one a great one!

Pytduss_aosty 21 St

Lloyd Woods

National Executive
Committeeman

Anthony G. “Tony” Jordan

Past National Command
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Emergency Assistance Plus (EA+)
on August 18th.

Quick reminder about EA+:

If you’re traveling away from home and experience
a medical emergency, EA+ steps in to provide
essential support services that can help you during
your emergency. Services include:

* Medical Evacuation to get you to a more
appropriate hospital.

* Transportation Home after hospitalization.

* Nurse Escort to help you travel if deemed
medically necessary.

* Return of Vehicle if it is stranded due to
your emergency.

* And More!

Product may not be available in all states and may
not mail to all your members. If you want a more
detailed description of this product, visit

www.TheLIT.com/Emergency-Assistance-Plus

Here’s what it will s B
look like to most e
people who receive it. -

gl

B

The next mailing is Accidental Death (AD)
in September.

We will be in attendance at the National
Convention in August.

LIT Fall Trust Directors meeting is
scheduled for September 14th in
Williamsburg, VA

So

[

For Veterans:
VETERANS

How are you doing? The opportunity to talk over
personal challenges in a free, confidential, and non-
judgmental setting is now available for anyone who
served for any length of time.

A veteran who is a trained Peer Support Specialist
is now available for a Monday group from 4p-5p
at the Lakes Region Recovery Center in Bridgton.

207-803-8707

AMERICAN LEGION
CUTTING BOARDS - $30/each

Purchase yours today at:

The American Legion,
Department of Maine Headquarters
5 Verti Drive, Winslow, ME 04901

Contact HQ @ 207.873.3299

MILITARY TRIVIA:

A: They were the only battleships fitted with a nu-
clear weapon, the W-19 artillery shell, equivalent
in yield to the bomb dropped on Hiroshima.
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SCHOOL ORATORICAL
SCHOLARSHIP CONTEST

The American Legion, Department of Maine High
School Oratorical Scholarship Contest will once
again be held at Thomas College in Waterville on
February 12, 2022 at 9:00 a.m. Snow Date: February
19, 2022 at 9:00 a.m.

The main purpose of The American Legion Oratorical
Contest “A Constitutional Speech Contest” is to
develop a deeper knowledge and appreciation for the
U.S. Constitution among high school students. Other
objectives of the contest include the development of
leadership qualities, the ability to think and speak
clearly and intelligently, and the preparation for
acceptance of the duties, responsibilities, the rights
and privileges of American citizenship.

Young orators will have the opportunity to earn
some of the most generous scholarships. At the Post
and District level, scholarships offered range from
$50 - $100, and at the State level $50 - $1500. At the
National level, each department (state) winner who
is certified and participates in the National Oratorical
Contest’s 1% round receives $2,000 scholarship.
Each first round winner who advances to and
participates in the second round, but does not
advance to the final round, will receive an additional
$2,000 scholarship to pursue education beyond high
school. The overall national contest winner gets an
$25,000 scholarship. Second place takes home
$22,500, and third gets $20,000. The members of
the Oratorical Committee will be working with both
Area and District Commanders to prepare Posts and
Districts for their local contests. We hope to have all
Post contests completed by Mid-December 2021 and all
District contests completed by the end of January 2022.

The 2022 National Finals is April 22-24 in
Indianapolis, at the Wyndham Indianapolis West.
Quarterfinal and semifinal contests are scheduled for
Saturday, April 23, with the finals scheduled for
Sunday, April 24. Certification of Department
winners is due to National by March 14, 2022.

For additional questions and/or information
pertaining to the Oratorical Contest in Maine, please
contact Oratorical Co-Chairman Dale Midgley at
207-590-3532 | e-mail: midgleyd@earthlink.net or
Oratorical Co-Chairman Maureen Malley at
maureenmalley.66(@gmail.com. More information
can be obtained by visiting www.mainelegion.org,
your local American Legion Post, or The American
Legion, Department of Maine Headquarters at
207-873-3229. Please check out the State and Local
Oratorical Contests by visiting National’s website at
www.legion.org/oratorical.

LETTER FROM THE ORATORICAL
CO-CHAIRMAN DALE MIDGLEY

If you have never attended the High School Oratorical
Finals, you are missing the opportunity to see some
of the very Brightest and Talented High School
Students in the State of Maine!

Did you know that: The Original proposed Bill of
Rights contained 12 Rights not 10?

Did you know that: James Madison, author of the
Bill of Rights, used the Magna Carta (1215),

English Bill of Rights (1689) and the Virginia
Declaration of Rights (1776) in writing the proposed
amendments to the Constitution.

Did you know that: The Constitution was finally
ratified by all 14 States in January 1791, the last
being Vermont.

Did you know that: A proposed Bill of Rights
Amendment submitted in 1789 was not officially
ratified until 1992 and became the 26th Amendment?

I didn’t know any of these things, plus a whole lot
more, until I attended our Post Oratorical Contest,
the District Oratorical Contest and the State Oratorical
Contest.

The students who research and present their
Prepared Speech and Assigned Topics will amaze
you by how much time and effort they have spent
rehearsing and polishing their presentations.

I hope to see you at the Oratorical Finals, for I am
sure, I will learn even more about the U.S. Constitu-
tion and the Bill of Rights again this year at the Post,
District and State Finals.

For the Oratorical Committee,
Dale Midgley

$$¢ Veterans

eee CrisisLine
1-800-273-8255 PRESS ©

For more information CLICK HERE or visit:
https://www.legion.org/benefits
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COMPUTER 101

Lo

Computer 101 is a resource which aims to help
those who wish to learn basic skills with the powerful
technology of today’s world. Increased proficiency
with computers and the Internet has positive outcome
across all fronts, both personally and professionally.

Top 10 Tips and Tricks For Using Microsoft Word
Copy, Paste and Cut with Keyboard Shortcuts

Ask anyone who knows these shortcuts, Ctrl + C to
copy, Ctrl + V to paste, and Ctrl + X to cut and they
will vouch for their basic timesaving nature.

Rapidly Zoom In or Out

Use the Window > Zoom (newer versions, Format >
Zoom), or search for the “100%” tab with a slider at
the bottom right of the document to zoom in or out.

Delete Entire Words at a Time

Hold down Backspace to remove words or entire
sentences, press Ctrl+Backspace with the cursor set
after a word you want to remove a word at a time.

Smart Lookup

Right-click on a word, you’ll see “Lookup” or
“Search”, with a magnifying glass. Click on it and
you’ll get a definition of the word.

Remove Unwanted Formatting

Press Ctrl + Space or click the Clear All Formatting
button. In newer versions, an eraser on the Home
tab) to remove formatting from highlighted text.

Use Multiple clicks to Select Text

Double-click over a word to select it or triple-click
to select an entire sentence or paragraph.

Rapidly Insert Links into a Document

Like the copy/paste/cut directions, taking in the key-
board shortcut for adding web links to a document,
Ctrl + K will spare loads of time and rapidly become
one of the keenest tools in your pack.

Select the Default Font you Want

Choose your default font for all new documents by
clicking Format > Font, select the properties you
want, and after that click Default.

Find Words or Text
Click Ctrl + F or click on Search in Document menu
to find words or text in a document.

IMPORTANT MILITARY DATES
August

> 8/4 US Coast Guard Established (1790)

8/5 Women Air force Service Pilots
Established (1943)

8/7 Purple Heart Medal Established (1782)
8/7 Vietnam War Began (1964)

8/13-15 Spirit of ’45 Day

8/14 End of War with Japan announced (1945)
8/14 National Navajo Code Talkers Day

8/16 National Airborne Day

8/19 National Aviation Day

8/26 Women’s Equality Day, Women Win the
Vote (1920)
8/31 Iraqi Freedom Ended (2010)

amazon

You shop. Amazon gives.
http://www.smile.amazon.com
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“Never give in. Never give in. Never, never, never,
never—in nothing, great or small, large or petty—
never give in, except to convictions of honour and
good sense. Never yield to force. Never yield to the
apparently overwhelming might of the enemy.”

~ Winston Churchill

“The nation which forgets its defenders
will be itself forgotten.”

~ Calvin Coolidge

“The supreme quality for leadership is
unquestionably integrity. Without it,
no real success is possible, no matter whether
it is on a section gang, a football field,
in an army, or in an office.”

~ Dwight Eisenhower
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